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Introduction
The Engine Polygraph® (www.EnginePolygraph.com) is an application ‘in the cloud’ to store the
FirstLook® sensor output (signatures) from an engine for future reference and to, optionally,
request an engine analysis report. To collect the signature data (waveforms), one uses an Engine
Polygraph® kit that includes two piezoelectric sensors, an automotive PicoScope, your laptop and
the Internet with a subscription to EnginePolygraph.com.
This document covers the functionality of the online web-based application,
www.enginepolygraph.com. Other documents describe details of the reports produced and the
associated (optional) PC application that simplifies the data collection and editing of the data
obtained (the signature), EPReader. Those documents are available for download from the
landing page of www.enginepolygraph.com.
A SenX signature (Fig. 1) is a record of voltage from one or more piezoelectric sensors recording
pressure changes (pulses) from an exhaust sensor and a crankcase sensor and optionally
additional sensors collecting data from other parts of an internal combustion engine. The value
to these signatures is that internal combustion engines repeat firing in the cylinders of the engine
in a regular fashion. If everything is working well in the engine the pulses repeat in very regular
waveforms; however, engine problems usually present variations that repeat every engine cycle
(two revolutions for 4-stroke engines).
The user may request an analysis (report) of the data in view of the engine model identified and
parameters of the test conditions. Currently the report choices are Assessment, Diagnostic, or
none. The Engine Polygraph® reports automate many of the steps that a user would perform
manually in interpreting a ‘signature’: a pair of SenX waveforms from an internal combustion
engine: one from the exhaust stream and the second from the oil dipstick tube.
If your engine has an intermittent problem, you might run your PicoScope to collect 32
consecutive waveforms and visually review them, looking for an example of what you think might
be the intermittent problem. You can save that single signature and upload it with the ADD
Signature function to get a Diagnostic report for that timeframe. (Try to find one that has the
abnormality away from the very beginning, but somewhat near the early part of the waveform.)
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In Figure 1 on the next page, the signature is from the exhaust (blue) and the pressure in the
crankcase (red) from a 6 year old, V6 engine. The vertical dashed bars mark the boundaries of a
720° full 2 rotations of the crankshaft which took 74.02 ms, indicating that the engine was running
at ‘Load’ of 1621 rpm.
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Figure 1. A SenX Signature using a PicoScope PC Oscilloscope.

Why are the signatures important?
In a 4-stroke engine, each cylinder of a well-running engine fires once during two rotations of the
crankshaft (every 720°); in a 2-stroke engine, every cylinder fires once during one rotation of the
crankshaft (360°).
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Over time, wear and tear on the engine will cause less-than-failure variation from cylinder to
cylinder. Most engines are not ‘broken’, but many are dirty (carbon buildup) or parts wearing
out. The cylinder that is changing the most is typically the one that will fail first. That is why it is
important to ‘look back’ at the signatures of an engine over time to identify if one (or a few)
cylinders are degrading and might need attention. By looking at the rate of degradation, one can
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In an engine with a problem of ‘physical integrity’, one or more (usually one) cylinders output an
abnormal pressure, resulting in an irregular pulse that is quite obvious. We use the term, ‘physical
integrity’ to refer to the engine moving parts: head gasket, valves, pistons, rings, cylinders, fuel
delivery, or ignition. Depending on where the signature is taken and the nature of the
abnormality, the problem can often be identified. In this way, an engine with a mechanical
problem can be diagnosed. [If the engine has tripped an OBD code AND the engine shows physical
component compromise, the problem might not be correctly identified by the code. Most codes
assume that the engine has no mechanical problems (no loss of physical integrity) but might have
sensor problems, or ancillary control system problems. If the engine has mechanical problems,
the code may well be erroneous.]

estimate the future time of failure. In this way, the sensor data can be used for ‘predictive failure’
to give you the option of preventative maintenance/repair or retirement. You may want to watch
the videos on the SenX Technology website: www.senxtech.com.

The Engine Polygraph® application
The EnginePolygraph application is designed for a shop of one or more people (mechanics and
technicians) who will take SenX signatures from engines. There are two ways to collect the
signature data. One approach can be used if there is not Internet access at the site of the engine
being tested. It is described in this document. The other approach that might be used is a PC
based software, EPReader, that does require Internet access while obtaining the data but also
provides prompts, edits and a much simpler process. It is described in the downloadable EP
Reader Installation and User Guide.
For the non-Internet method, it is necessary to have the signature stored on your local computer,
typically a laptop in the shop with your PC oscilloscope. The local storage of the signature can be
done without connection to the internet. The procedure for the non-Internet method is
described in the downloadable Polygraph Quick reference Guide.
EnginePolygraph allows you to attach ‘index’ data to the signatures for easy future retrieval;
the index data and the signature are then sent to the EnginePolygraph application.
EnginePolygraph is a web-based application and database, so it is necessary that your computer
be attached to the internet, perhaps at a later time after you have collected the signature data,
in case you do not have internet access at the vehicle location when obtaining the signature.
There are three types of user accounts in EnginePolygraph:
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1. The Account Manager holds the credit card for payments and this account establishes the
‘umbrella account’ for all activity input by other user accounts (usernames) authorized by
the administrator(s). The username that creates the Company account is called an Owner.
2. An Administrator account has authority to establish additional usernames and deactivate usernames for use of the EnginePolygraph application. Administrators are
empowered to create additional usernames, assign them as Administrators or not, and
change their status (Active or Inactive). By default, the Account Manager is setup also as
an Administrator account.
3. A non-administrator account that is active can search, add, delete, edit, and view
signatures and request and view Engine Assessment or Diagnostic reports. This is a typical
account for a technician responsible for collecting the signature data (testing the engine)
and reviewing the output with an end-customer.
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You connect to the EnginePolygraph application with www.EnginePolygraph.com.

Figure 2. Landing page for Engine Polygraph.
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Below the Log-in box, there is a list of documents that you may download by tapping the title.
And below that is a list of videos to provide additional information about Engine Polygraph and
the FirstLook® sensor technology.
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Notice that you may select the language you wish to use from the pull-down list of supported
languages near the top right of the border panel.

The EPReader productivity aid
Although EnginePolygraph is a complete application enabling data collection, report generation
and signature/report storage and retrieval, we also provide EPReader as a PC software to simplify
the data collection and transmission to the Engine Polygraph web application. After
implementation of Engine Polygraph, you may use it to download and install the EPReader. (See
below.) The EPReader Installation and Users Guide can be downloaded from the Engine
Polygraph sign-in screen. You can also find the EPReader Quick Start instruction set to summarize
the steps when using EPReader to obtain a signature from an engine.
But only the EnginePolygraph internet application contains the screens to register your company,
provide administrative functions, and allows access to the history of your signatures and reports.

Registration
The first time you Log in, you must register your company as a new customer and subscribe to
the service with a credit card in order to proceed. You will want to read our Privacy Policy and
our Terms and Conditions before you actually use the credit card in order to feel comfortable
that we will respect you and any data you present to us for safekeeping. As mentioned in the
Privacy Policy, you must allow cookies to be active on your computer to enable the ‘Remember
me?’ option for your computer.
If you do register your company for a subscription on EnginePolygraph (EP), you will want to
select a Company Username that identifies the company; as an administrator, provide your
name and contact information for communication with us in case of questions. When you
advance in the Company and turn this responsibility over to someone else, change the name and
contact information on this Company Username account to reflect the new person.
As an Account Manager, you may add any other people you authorize (or remove authorization)
to have Admin or Account Manager Authority.
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As an Administrator, you may add any other people you authorize to access any of the signatures
that anyone in your shop inputs to the database. Any user so authorized can input new signatures
or change the index content on previously entered signatures. They may also request EP Analytics
Reports. So it is important that you have each person in your shop who will need access to have
their own username and password.
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But first, you must register your company and yourself as administrator. Fill out the NEW
CUSTOMER REGISTRATION screen (Fig. 3):

Figure 3. Screen image for ‘Register as a new company’.
You will notice that when you identify your company’s Country by selecting an appropriate entry
from the pull-down that the appropriate State/Province/Region codes will appear for you to
select the one that is appropriate for your country.

Price Key
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On the NEW CUSTOMER REGISTRATION screen, you will see the WELCOME Price Key. Your
EnginePolygraph distributor might have provided you with another Price Key to give you an
alternative pricing program with a different balance between subscription and reduced
assessment report prices. You may enter that Price Key into the PRICE KEY field and SAVE it, then
the appropriate pricing will be applied.
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After you have completed the registration, you are presented the CREATE SUBSCRIPTION page.
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Figure 4. Billing information to provide credit card information for secure payments for any
subscription fees and Engine Assessments.
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After you submit a valid credit card for processing, you will be presented the following screen
(Figure 5):

Figure 5. Dashboard Menu for a successful newly registered customer.
You might want to click on Click on USERS, then Add New User to add the others (mechanics and
technicians) in your organization to authorize them to have access. You may assign them a
password which they will have to change when they first Log in, or you may request that the
system generate a random password and send it via email to them. They will have to reset the
password on the first time that they Log in.
You may authorize anyone else to also be an administrator; just don’t revoke your administration
authority before you have authorized someone else to take over that responsibility.

First Time Log in
A newly authorized person can Log in to EnginePolygraph using the password assigned by the
administrator; however, the User must reset the password before he/she can perform any other
system function. Use the My Account option on the DASHBOARD panel to change contact
information or reset your password. (Or you may click on your username in the upper right of the
screen to get the My Account screen.)
Forgot your password? :
If you forget your password, click on the Forgot Password link on the Landing page. You will be
presented a screen requesting your Username.
1. If you enter a valid Username, the system will send an email to the email address in that
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Username record.
2. The email will contain a link to use to reset your password. The link is unique to your account
and will expire after 24 hours.
3. Click on that link, then enter and confirm your new password on that page.

© Predictive Fleet Technologies, Inc., 2020; All rights reserved; Patent numbers: US10253716B2 and US 20190304214A1
info@PredictiveFleetTechnologies.com Phone: 1-833-ENGANGL (364-2645)
User Guide, ver 6.00

Home (DASHBOARD)
The following is the typical DASHBOARD that a technician/mechanic will see upon Log in. (Fig.
6.)

Figure 6. Dashboard/Menu presented to a successful log in by a technician.

Signatures
There are two times when it is important to retrieve a previously stored signature. First, if a
customer comes into the shop with a vehicle that you have previously serviced, you might look
up the details of that previous signature to save you time entering details about the vehicle and
its engine again. Secondly, after you have completed storing the signatures for a vehicle, you will
probably want to compare these new signature reports with the signatures that you have
previously stored for the same vehicle. By comparing the differences, deterioration of various
components over time might be visible.

Searching for a previously stored Signature
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Upon entry, the Signatures panel shows a table of the most recent signatures stored from your
shop. Upon visual inspection you might find the signature that you are interested in, especially if
you are adding one or more signatures to a vehicle that you have recently worked on. You may
select either the edit or delete buttons, depending on your situation. (See Fig. 7.) If you look at
the details by clicking the edit button, you can then click on the tab button SIGNATURES to get
back to the signatures panel. Then click on the Add New Signature button and many of the data
elements from the record that you selected for edit will be on the add screen. (Be sure to verify
the ODOMETER, RPM Source, RPM, and TEMPERATURE fields as they may well be different from
the previous signature.)
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Figure 7. EDIT and DELETE buttons are on the left side of the screen.
On the SIGNATURES and ASSESSMENTS screens, additional data shows when you ‘mouse over’
the data shown for each row. As shown below in Fig. 8, VEHICLE has OWNER identification; the
PURPOSE describes the purpose of the specific signature on that line (Single if it is one-off, Before
if it is taken prior to a maintenance procedure, After if it is taken to show engine ‘health’ after a
procedure, and Base if it is an ‘as-new’ signature for this engine model). The vehicle ODOMETER
has engine RPM and coolant TEMP (temperature) values at the time of the Signature in the
‘mouse-over box; likewise, (Engine) MODEL has MFGR (engine manufacturer), CONFIG
(configuration), and engine DISPLACEMENT in liters; DATE has LOCATION (identification of the
place when and where the test was done); CONDITION has the associated Pico Channels and how
they are attached to the sensors; and FILE provides any COMMENTS entered by the technician
pertaining to this Signature and the psdata FILE title. If you click on the FILE icon, the psdata file
will be downloaded to your workstation.
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Figure 8. Example of results of a ‘mouse over’ of data in column ODOMETER in the first row.
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If the signature you are looking for was stored some time ago, you may want to select the “Search
Engine Signatures” on the upper right of the panel. Then a Search Specifications box opens for
you to select the columns you wish to search for specific values or ranges.

Figure 9. Search request box on upper right of the screen.

Figure 10. Search Drop-down panel.
Add Filters as desired. Each added Filter is a further
restriction on what will be returned.

Figure 11. Example of search
box for a numeric value
between a lower and upper
limit to the search.
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As shown in Fig. 11 and 12, the limits you may place on the contents of each field depend on the
characteristics of the field. For example, fields that contain numbers can be limited by specifying
a low value and a high value that you are interested in. (If you wish to say less than a particular
value, use the low value as a large negative number or zero, and the higher value would be set
to the highest value that you are interested in.) Fields that just have text can be limited to those
that contain a word, phrase, or portion of a word; a record will be returned if whatever value you
specify can be found in the field. If the field comes from a pull-down list, you may select a value
from the list as the requirement for that the field. If you wish to search on a date field, you must
specify the earliest date to the latest date of the records you are interested in.
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Figure 12. Example search with pull-down, value ranges, and Date parameters.

In Fig. 13, we show the row(s) that satisfy the search criteria.

Viewing the Signature file retrieved (if it were submitted as a *.psdata file)
On the right on the Search Results panel you can see the FILEs associated with your search Filters
(Figure 14). Click on the FILE (Signature) icon for a panel allowing you to specify where you want
the Signature stored. You may then open the signature for viewing by the oscilloscope software
that you used to capture the signature. In this example, we will select an above referenced FILE:

© Predictive Fleet Technologies, Inc., 2020; All rights reserved; Patent numbers: US10253716B2 and US 20190304214A1
info@PredictiveFleetTechnologies.com Phone: 1-833-ENGANGL (364-2645)
User Guide, ver 6.00

Page

You will be prompted to specify the file name and directory for the signature that you have
selected. (You must have the PC Oscilloscope software installed on your local workstation to view
the file.) “Save” the FILE as shown in Fig. 15.:
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Figure 14. Identification of the Signature file with active link to download it.

“Double click” (or Open) the button on the bottom left to initiate the signature viewer (Fig. 15).

Figure 15. Link to open the Oscilloscope software on your device.
Figure 16 shows the screen image from a PicoScope of a SenX FirstLook Signature.

Figure 16. Image of a Signature of a V6 as displayed by PicoScope.

Download an Excel spreadsheet of searched signatures
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You may open the spreadsheet by “Double click” on the csv file name. (Fig. 17)
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You may want to extract the results of your search into an Excel spreadsheet. Actually, a csv file
(comma separated variables) will be stored. To do this, click on the EXPORT button on the lower
left of the screen that has the results of your search and Save the file.

Figure 17. Button to request a download (Export) of the data supplied to the display in a csv file.
The spreadsheet file contains some additional columns. The username of the index entry creator
and the creation date are displayed along with the last update username and last update date
time. These columns can be very useful for tracking down questionable entries.

Correct a mistake on an index
To reset the list of signatures back to the beginning state (before the search), click on the
SIGNATURES tab on the top of the screen. To correct a value on the index data, click the “EDIT”
button on the left side of the row to get a panel loaded with the data of the index (Fig. 18 on the
next page).
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All fields on the screen must have an entry except unused channels, RPM (depending on the RPM
Source, and the Remarks field which are optional.
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Make any appropriate corrections and click on the “Save” button on the bottom. In the above
example, it might be to correct Index data for the previously loaded signature. Notice that you
may request a report from this screen in case the previous request was not processed because
of an erroneous entry in one (or more) fields: RPM, channel assignments, ...). Typically, you will
want the previously submitted file to be used for any new report, so you would not upload the
old file. In that case, you would not be charged for the new report; if you do upload a new file,
you will be charged according to your price key. If you are signed in with a different language
than the language that was used on the original entry, the report will be translated to your
language. (This language translation is just being implemented so the completeness of the
translation will be improving over time.)
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Figure 18. Signature EDIT screen with data from a selected signature, ready for edit.

Add a new Signature
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To add a new signature, click on the “Add New Signature” button on the top left side of the panel.
The Add panel will typically contain data from the previous entry. Modify the index data as
appropriate and attach the newly obtained signature file. Then “Save”. It is necessary to input
values into each field on the screen except for unused channels and the optional Remarks field.
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It is important to add the index information to a new signature as soon as possible after the
signature has been obtained (or you may fill the screen before obtaining the signature; obtain
the signature and then upload it on the Add Signature screen). The fields that contain description
of the owner, vehicle, date and location are remembered from the previous entry. Some of the
time, one takes several signatures from one vehicle under different conditions before starting on
another vehicle. The engine speed (RPM) and engine temperature typically change somewhat
between signatures.

First time for this OWNER
There are two types of owners of the vehicles that you service. The owner might be the name of
a fleet, in which case it is important that the name be typed correctly for future reference. Or the
owner might be an individual with a personal vehicle being serviced.
If this Owner (your customer) is new to EnginePolygraph, it will be assumed that the Owner is
NOT already an Engine Angel customer with pre-paid access to assessments of vehicles in that
fleet. If, however, the fleet owner is an Engine Angel customer, the Owner has screens in Engine
Angel to ‘connect’ your EnginePolygraph to their Engine Angel system so assessment report data
will flow from your EnginePolygraph to their Engine Angel databases. [You would be registered
as a ‘Data Provider’ to your customer on their Master Data → Data Connections → External Data
Provider screens.] If you need more information, contact the Engine Angel Sales team
(support@PredictiveFleetTechnologies.com) to help ‘connect’ the Owner’s identification with
the Engine Angel fleet identification.
As you type the Owner identification, the system will display previous owners also named that
way. This is not only to minimize the ‘misspelling’ of a previous Owner, but to determine if the
Owner is a subscriber to Engine Angel with rights to pre-paid assessments. The pre-paid
assessments apply only to vehicles that have been registered in the Engine Angel fleet.
Engine Angel customers
If your customer is an Engine Angel customer as well, and they have set you up as a Data Source
for providing EP signatures for them, your screens will have some additional features. The vehicle
brought in is most probably known to Engine Angel as a Vehicle registered in their Fleet. When
you put their Fleet identification in the Owner field, their Fleet ID (as known by Engine Angel) will
be displayed on the right top portion of the screen and there will be checkmark alongside the
‘Engine Angel Subscriber’ to indicate that they have prepaid for reports.

Figure 19. Display on Add or Edit Signature when the Vehicle is part of an Engine Angel Fleet.
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If the Vehicle ID is found on their list of vehicles, the Vehicle ID will appear in black. Otherwise
the vehicle is displayed in red, which indicates that this vehicle is not on their list of vehicles. They
might be asking for an assessment of a used vehicle for consideration to buy – or it might be that
the Vehicle Id is not correct. See Fig. 19 for an example of Vehicle ID 184 that is registered to the
Owner of Fleet ID = DemoFleet1.

First time for this Vehicle
You will want to establish a convention for your shop for identifying vehicles. In the case of fleet
vehicles, a vehicle number is usually painted on the door, fender or hood; for individuals, a license
plate number might be appropriate.
If the Owner is not an Engine Angel subscriber, the user will be asked to provide the engine
manufacturer and model.
If the Owner is an Engine Angel subscriber, the Vehicle Id will be checked on the fleet’s list of
Engine Angel registered vehicles. If it is found, the engine manufacturer and model,
configuration, and displacement (liters) will be provided. If the Vehicle Id is not registered to the
fleet, it will appear in red on the request screen and if ‘accepted’ by the user, the user will be
asked to provide the engine manufacturer and model.
In all cases, the system will pick up the number of cylinders and the number of strokes from the
Engine Angel engine databases. If the Diagnosis report is requested, many more engine
specifications will be obtained from the Engine Model table.

How do I get a new MANUFACTURER or MODEL added to the Pull-down list?
If the pull-down list provided for manufacturer or model does not contain values for your
customer’s vehicle, please send an email to support@PredictiveFleetTechnologies.com. In the
interim, make note of what you need in the Comments field for that signature and choose a
different model with the same configuration, number of cylinders, and similar displacement.
After Engine Angel has updated the pull-down list, we will let you know so that you may edit
these entries.

Additional Signatures for a known OWNER-VEHICLE
If you are adding multiple signatures for the same owner vehicle, simply click the Add New
Signature button after you have Saved the previous entry. The data elements describing the
owner and vehicle will be copied forward. You will want to review all the data copied forward to
make sure they are all correct.
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The Odometer reading probably will not change between multiple signatures for the same
vehicle on the same date. But be sure to verify it. The engine coolant Temperature is also
important to know because some interpretation (especially for diesels) is dependent on the
engine temperature. If the input value is under 105, it will be interpreted as °C; otherwise as °F.
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The Location entry will rarely require change if the shop name is used; the Measurement Date is
pre-loaded to today’s date, so if this is an entry for a signature from times past, replace the
current date with the correct date for the signature.
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Condition is important to be correct for valid interpretation of the signatures. For example, the
blow-by is greatest in a cold-crank (‘c-c’) near the end of a compression stroke, but it is maximum
in the power stroke during a hot test (‘Idle’ or ‘Load’). The RPM Source is a selection from a pulldown of options. Choices include:
a. None indicates that you want the system to provide a default that will be obtained based
on the Condition and number of cylinders. RPM may be left blank.
b. Estimate means that you will input a value for RPM that is based on reading a tachometer
or other method to provide a reasonable RPM value.
c. ECM means that you have a Bluetooth ECM reader plugged in to transmit the engine RPM
to the EP Reader while the signature data is collected. RPM may be left blank.
d. Set RPM means that your engine has a digital input to command the ECM to control the
engine speed that you specify to the digital throttle. You then also provide that value to
the input RPM field.
e. Trigger channel (not yet implemented) means that you have assigned an ignition
detection device (such as an induction coil to provide voltage to a coil-on-to or spark plug)
as one of the channels on the PicoScope,
If the RPM is known accurately, it is valuable in the interpretation of the signature. In the case of
RPM, if the value input is less than 200 or greater than 6000, a report will not be generated;
otherwise, it may be used in the RPM calculation process. If it is more than 15% off from the
actual engine speed, it may make the calculation worse.
The ‘Channel x’ fields need to be aligned with the oscilloscope channels and how they are
attached to the sensors. If you happen to discover a mix-up on the assignments after the fact,
you may use the EDIT button on the Signatures screen to submit a revised assignment and get a
new report.
You typically will want to record the Purpose for the requested report: ‘Before’ indicates the
signature is being taken before some procedure is to be considered; an ‘After is for a report on
the engine ‘health’ following the procedure. Choose ‘Single’ if the report is a routine evaluation
of the engine without an intended maintenance procedure that will be validated after the
procedure; ‘Base’ is used to report an ‘as new’ engine report for future reference.
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You may want to input Comments to further uniquely represent this signature in the future or to
‘group’ the signatures for your particular analysis or organization needs.
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The Trigger Cylinder is important if you have a sensor for identifying ignition events. If your
sensor (often a current induction clamp or a spark antenna) is designed to detect the ignition
events on only one cylinder, input the cylinder number that is monitored; if the sensor records
the events for multiple cylinders, do not specify any one cylinder. The trigger signal is used to
calculate RPM; but if one cylinder can be uniquely identified, it can be very useful in identifying
which cylinder(s) has/have diagnosed conditions.
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You chose the report you desire in the Report Selection pull-down: Assessment, Diagnostic, or
‘none’. If you chose a report, a ‘Send Report (PDF) to:’ email address will be requested.

Engine Polygraph Reports
Engine reports are produced from analysis of certain signatures. There are currently two reports
are available for selection. The Engine Polygraph® reports automate many of the steps that a user
would perform manually in interpreting a ‘signature’: a pair of FirstLook® waveforms from an
internal combustion engine, one from the exhaust stream and the second from the oil dipstick
tube.
The Assessment report is an analysis of a signature with simultaneous 'exhaust' and 'oil tube'
pressure sensor readings that calculates 'scores' with values from 1 (very good) to 9 (very poor)
ranking the 6 quality ‘measures’. The scores are generated from a mathematical model ‘trained’
with examples of data from engines with assignments made by experts. The report is available
as a PDF, and if the Owner is a subscriber to Engine Angel, the results are stored in the database
to show time-series graphics of the scores over time.
The scores are: an overall engine score and scores for the upper engine (valves, injectors, head
gasket, ignition), engine volumetric efficiency score, and a score for valve seating leakage; and
scores for the lower engine (rings, pistons, cylinder walls), rumble (humming), and scraping (high
frequency screeching). The overall score is indicating the current state of the engine and a
measure of risk that one of the monitored components will fail soon – it is NOT a measure of the
remaining life of the vehicle although that is related.
The Assessment report contents are described in a separate document, EP Assessment Report,
available for download from www.EnginePolygraph.com.
The Diagnostic report is an analysis of the data from a ‘Signature’ file of data, data about the
engine model being tested, and some test conditions data. The report evaluates the ‘physical
integrity’ of the engine AND an Expert System evaluates ‘Abnormal Observations’ detected to
produce a list of possible causes of the Abnormal Observations along with a confidence that the
indicated cause is correct and suggestions that might remedy the problem.

© Predictive Fleet Technologies, Inc., 2020; All rights reserved; Patent numbers: US10253716B2 and US 20190304214A1
info@PredictiveFleetTechnologies.com Phone: 1-833-ENGANGL (364-2645)
User Guide, ver 6.00

Page

The Diagnostic report also displays information about the engine model that is being analyzed.
This includes an engine block diagram, firing order, cylinder adjacency matrix, and the cylinder
offset diagram relating the stroke of each cylinder as the crankshaft rotates through the firing
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Currently, the system will produce reports for signatures with exhaust and oil tube sensors in the
Load (running at about 1500 rpm) or Idle condition. Optionally, a channel can be assigned to the
trigger sensor (usually a clamp inductor to detect current in a spark-plug firing or an injector
signal for a specific cylinder). A fourth channel can be assigned to another sensor (e.g., an intake
manifold or vacuum line); however, any additional waveforms will only be displayed on the
report. It is not (currently) included in the engine analysis for the report.

cycle. In addition, distinctive engine technologies and common problems are listed as they
become known to PFT.
The Diagnostic report contents are described in a separate document, EP Diagnostic Report,
available for download from www.EnginePolygraph.com.

Search and Retrieval of Reports
Previously processed reports can be displayed from the Assessments tab, as shown in Fig. 20,
below:

‘View’ icon (Eye)

‘Email’ icon

Figure 20. EnginePolygraph Assessments screen
A report can be in a ‘processing’ state, indicating that the report request has been sent to, but
not yet processed by the system. Once the assessment has been received (usually in less than 2
minutes), the signature is shown with the View and Email options. The View button will start a
‘download’ process to your workstation for local storage and viewing. The email option allows
easy email capability to send the PDF report as an attachment to a provided email address.
If the submitted signature does not have data that can generate a meaningful report, the system
will produce a PDF ‘Exception’ report describing the issue and suggesting corrective action. You
will not be charged for a request that results in this circumstance. The most common reason for
inadequate data in the signature file for a meaningful report is that the PC oscilloscope settings
might not be appropriate for the engine you are working with. Please review the Appendix:
PicoScope Startup Settings if you want more information.
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As mentioned earlier, if the analysis program is unable to reliably provide a useful report from
the submitted data, you will receive an Exception report on the Assessments screen. The
Exception reports are highlighted as a yellow box. The PDF report is downloaded when you click
on the yellow button.
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Exception Reports

The nature of the problem and corrective action you might be able to take is provided in the
report. See Fig. 21 for an example Exception report as it presents on the Assessments page.
Fig. 22 has the Exception report for the situation of Fig. 21.

Figure 21. Assessments page showing a signature that could not be interpreted enough to
generate a useful Assessment report.

Engine Polygraph Exception Report

Figure 22. Example message presented on the Assessments page when the software is unable
to process a submitted signature for analysis.
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The reports can be requested for new signatures when adding and for previously entered
signatures. In both cases, the request is made on the Add/Edit screen. (This is different from
requesting a copy of a previously generated report, which is detailed on the Assessments page.)
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Request Reports

Request Report while Adding New Signatures
If a new signature add is made for an Owner (customer) who is an Engine Angel subscriber and
the vehicle identified has been registered to the fleet, and the user has requested a report, the
system will generate the requested report and the Engine Angel databases and on-line reports
will be updated after it has been produced. There will be no charge since the Engine Angel
subscription covers the cost of reports. Of course, there are situations when the data does not
support the generation of such a report – the signature may be empty, it may not have the
sensors identified correctly, etc. In such cases, you will not be charged for the attempt but will
receive an Exception report describing the situation with recommended action to get a useful
report.
If a signature is being added for an Owner (customer) who is not an Engine Angel subscriber, the
user may request a report to be generated, sent to an indicated email address, and posted on
the Assessments page. The account for the EnginePolygraph subscription will be charged for the
indicated amount.
If a new signature add is made for an Owner (customer) who is an Engine Angel subscriber and
the vehicle identified has NOT been registered to the fleet, the user may request a report to be
generated, sent to an indicated email address, and posted on the Assessments page. The account
for the EnginePolygraph subscription will be charged for the indicated amount. (In other words,
the report data will not be sent to Engine Angel because that vehicle is not in the Fleet’s database.
The fleet owner might be evaluating the engine prior to purchase.)

Request a Report for Previously Added Signatures
From the Signatures page, one can access previous signatures and request a report to be
delivered by PDF for a fee. (It might be worthwhile to first use the filters to search on the
Assessments page to see if the signature assessment report has already been generated so that
it might be merely downloaded.)
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Once the signature has been found on the Signatures page, select Edit and make any corrections
or add a comment, if desired. You MAY upload a new signature to replace the existing one in the
system, but this is expected to be rare. If a replacement signature is uploaded, it will replace the
earlier signature and its report and the new report will record as a new signature for charge. The
typical situation for edits is that you would not upload a signature, in which case the system will
use the previously uploaded signature and no charge will be incurred. If the Owner were not an
Engine Angel subscriber at the time of the signature upload but now is, the signature will be sent
for a report but the report will not be sent to the Engine Angel subscriber..
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EPReader Install
The Engine Polygraph Reader Install button initiates the process to download to your PC the
EPReader application to simplify the collection of the sensor data and to send that data to the
Engine Polygraph web application for processing.
The EPReader Installation and User Guide and EPReader Quick Start can be downloaded from the
Documents list on the login page.

Administrator Functions
If you are authorized as an administrator, this section will be of interest to you. As an
administrator, you are responsible to maintain the authorizations of the staff (USERS) in your
company/shop. At least one person in the organization must have the administrator
authorization.
The other responsibility that you have as an administrator is to maintain the company
information and keep the subscriptions active. Engine Polygraph has an automated charge from
your credit card monthly and an email is sent to the Company contact when the charge (any
monthly subscription fee plus individual assessment fees for the past month) is posted.

USER Management
It is important to add new mechanics/technicians to the system as soon as they start to work. All
users must use their own username and password to access the system in order to provide audit
trails to clear up confusion and mistakes. If there are delays in adding a new employee, it
becomes tempting to have the new employee use a username and password of an existing
employee, creating bad habits.
It is also very important to explain to your employees that the data they are collecting about the
owners and vehicles is confidential and not to be shared outside of work.
It is important to deactivate employees when they leave the organization and to remind them
before they leave that they are obligated to respect the proprietary nature of the data they were
exposed to.
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There is a search function for the employees who have been added to the roster of authorized
users. For large shops especially, is important to use the search function before adding a new
username to minimize confusion in the future. See Fig. 23. You may put any string of letters in
the Search field to return only records containing your search string.

26

Search of UserNames
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Figure 23. Screen showing list of Usernames authorized for the EnginePolygraph of your
‘system’.

Edit User Data and Authorization
The administrator will use the edit function of the Users List screen to change the contact
information or status of an employee from active (yes or no) and to assign or remove admin
authority. See Fig. 24.
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Figure 24. Edit or Add screen for maintaining or adding User profiles for your system.
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Add NEW USER

When adding a new username to the system, the administrator may assign a password and
communicate that password to the new employee verbally, or the administrator may request the
system to send an email to that new employee with a random password. In either case, the new
employee will have to reset the password on his/her first Log in. (See Fig. 25.)

Fig. 25. The password format requirements show when the cursor is entered to the password
fields.
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The cursor will not allow you to proceed if you input a password request that does not satisfy the
requirements edits in the pop-up window.

© Predictive Fleet Technologies, Inc., 2020; All rights reserved; Patent numbers: US10253716B2 and US 20190304214A1
info@PredictiveFleetTechnologies.com Phone: 1-833-ENGANGL (364-2645)
User Guide, ver 6.00

Edit Company
The Account Manager is responsible to maintain the correct Price Key (with appropriate
subscription and Assessment report prices). That data is available on the Edit Company screen as
shown in Fig. 25. The link at the bottom of the screen, Change your billing information, is used to
update your credit card information. If you change a Price Key, the price data will update after
you SAVE the change.

Figure 25. Edit Company screen to maintain Company contact information and presented Price
Key name.
Prices for the monthly subscription plan and the OOR Assessment reports are determined from
the Price Key that was provided when your registration was completed, or when last updated by
a new Price Key or when your distributor provides a new version of the Price Key.
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The Account Manager is also responsible to maintain the correct contact information for the
company to allow communication between your company and Engine Angel. That data is also
available on the Edit Company screen.
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Create/Extend/Change Subscription
The subscription plan is for unlimited uploads, searches and downloads within your organization.
The ‘per/month’ charge is applied to the credit card specified until the credit card expires or the
subscription is terminated.
Requests for Assessments are charged to this
account when an Assessment report is
completed.

Edit Billing Info:
Changes to the credit card information can
be made from the ‘EDIT COMPANY’ tab and
‘clicking on’ the ‘change your billing
information’ option on the lower part of the
page. See Fig. 26.
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Figure 26. Window to securely provide changed credit card information for monthly payment of
any subscription and Assessment report charges.
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Warranty and Disclaimers
Predictive Fleet Technologies, Inc. (PFT) warrants the software will work as described. The
warranty does not cover any problems with the Internet connection or your common-browser
(Internet Explorer, Chrome, or FireFox) compliant workstation (desktop, laptop, or tablet). We
will store your signatures, up to 10 meg (typical values are under 400 KB), and maintain them in
a searchable and retrievable manner as described in the accompanying document. We use
standard security, data and application backup & restore methods to protect your data
investments from most natural and criminal events. If data are deleted or changed by people
whom you have authorized, we cannot guarantee recovery.
The Engine Polygraph® Assessment report automates many of the steps that a user would
perform manually in interpreting a SenX FirstLook® (FLS) waveform from an internal combustion
engine. It requires a waveform of adequate strength and sample frequency generated by the
customer’s oscilloscope such that meaningful information can be detected from the signal.
Meaningful results can be expected only if the testing procedure is correctly followed; e.g., the
connections of the cables are reliable, the equipment (oscilloscope, cables, sensors, etc.) work
satisfactorily, and the oscilloscope parameters are set to reasonable values of duration (about 4
rotations of the engine crankcase), sampling at about 40kHz per channel).
It is also required that certain inputs to the EnginePolygraph report request be accurate: the
engine manufacturer and model must at least have the correct engine configuration & strokes
per cycle and the approximate RPM input to the EnginePolygraph application is assumed to be
within +/- 15% of the actual value.
The Engine Angel Assessment is NOT designed to measure misfires due to conditions such as poor
fuel or irregular ignition. The Engine Angel software looks for defects that are measurable with
each engine configuration (in-line, ‘V’, etc.) of either cycle (2- or 4-stroke).
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It is up to you to decide what action you should take based on the requested report. The
recommendations we make are based on feedback from others’ experiences. PFT is not liable for
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The Assessment report uses advanced mathematical methods to classify the cylinder features
extracted from the signatures: one from the exhaust and the other from the crankcase, usually
via the oil dipstick tube. It is required that the oscilloscope channels are assigned correctly, in
alignment with the connections and placement of the FirstLook® sensors. If the exhaust system
has holes allowing exhaust to prematurely escape before reaching the sensor, or if particulate
filters reduce or ‘average’ the pressure at the sensor to a very distorted level, meaningful results
will not be achieved. Upon receiving a meaningful signature file, the Assessment report will
display the results of a ‘supervised learning’ software to classify the condition of the engine’s
‘upper’ and ‘lower’ components based on observation of many other engines. The measures of
volumetric efficiency and valve seating condition are based on other methods. These
classifications will likely improve over time and newer versions (as displayed on the report) will
provide those improved results when available to you, the customer.

damages resulting from the implementations of such recommendations; we provide them to you
for your judgment in decisions on what to do.
THERE IS NO WARRANTY OF MERCHANTABILITY. THERE ARE NO WARRANTIES WHICH EXTEND BEYOND
THE DESCRIPTION HEREIN. THERE ARE NO WARRANTIES EXPRESSED OR IMPLIED OR ANY AFFIRMATION
OF FACT OR REPRESENTATION EXCEPT AS SET FORTH HEREIN.

REMEDY
If you suspect that there has been an error in the storage, indexing, assessment or retrieval of
your data, please contact us immediately at support@PredictiveFleetTechnologies.com and/or
contact us by phone: 1-833-364-2645. We will work with you to understand what happened and
what recovery plan we can put in place.
In no event shall PFT be liable for damages of any nature, including incidental or consequential
damages, including but not limited to any damages resulting from non-conformity, defect in
design or workmanship.
Neither PFT nor its affiliates shall be liable to the subscriber of this product or third parties for
damages, losses, costs, or expenses incurred by the subscriber or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations
to this product, or failure to strictly comply with PFT’s operating and maintenance instructions.

Contact Us
Learn more about us at www.PredictiveFleetTechnologies.com, www.EnginePolygraph.com,
and www.EngineAngel.com.
For specific questions about the Engine Polygraph® functionality, please email us at
support@PredictiveFleetTechnologies.com or call us at 1-833-364-2645.
1

SenX is a trademark of SenX Technology, Inc., Midland. MI
Predictive Fleet Technologies®, PFT, Engine Angel®, and Engine Polygraph® are trademarks of Predictive Fleet
Technologies, Inc., Inc., Midland, MI
2
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No part of this publication may be reproduced or transmitted in any form or by any means, electronic, mechanical,
photocopying, recording, or otherwise, to parties outside your organization as a customer or customer prospect
without the prior written permission of PFT.

© Predictive Fleet Technologies, Inc., 2020; All rights reserved; Patent numbers: US10253716B2 and US 20190304214A1
info@PredictiveFleetTechnologies.com Phone: 1-833-ENGANGL (364-2645)
User Guide, ver 6.00

Appendix 1: Glossary
Engine Polygraph® Glossary

Predictive Fleet
Technologies

Predictive Fleet Technologies is the name of the company that developed, supports, and
operates the Engine Polygraph® software .

Assessment report

Assessment is the analysis of a 'Load' condition signature with simultaneous 'exhaust' and
'oil tube' sensor recordings that calculates 'scores' with values from 1 (very good) to 9
(very poor). The information is available as a PDF, and if the Owner is a subscriber to
Engine Angel, in the database for time series graphics of the scores over time.

Assmnt rate
(Assessment rate)
CHANNEL x

The price that the customer will pay to obtain an EnginePolygraph Assessment report IF
the customerPrice Key indicates that the customer wishes to pay on a ‘per report’ basis. It
is passed to invoicing for OOR reports if the Price Key indicates ‘Credit’.
The channel identifier tells which of several SenX FirstLook® sensors is attached to which
channel on the oscilloscope. The options for where to place the SenX first look sensor are
provided in a pull-down.

COMMENTS

Comments are free text entries on a signature index to help retrieve them in the future.

Company

A company is the paying customer of an EnginePolygraph subscription. It typically is a
vehicle maintenance/repair facility. It may have one or more locations, but multiple
locations should each have their own subscription unless their customer vehicles are
serviced at multiple locations.

Confidence

Confidence (that a specific Cause is present in this engine at the time of the signature) is
assigned based on the number and severity of the Abnormal Observations attributed to a
Cause compared to the total number and severity of all Abnormal Observations identified
from this signature.

CONDITION

The condition of an engine describes the state of the engine during a single signature file.
The values are obtained from a pull-down, including idle, load, and cold crank (c-c). Idle is
typically under 1000 RPM, load is about 1500 RPM, cold crank occurs when the engine is
turning over under the power of the starter.

CONFIG or Engine
Configuration

Config is short for configuration. The configuration of an engine describes the number of
cylinders in the orientation of the cylinders with respect to each other. Its value is
obtained from the EngineAngel database for the selected engine model. (E.G., V6 or I4)

Cylinder Adjacency
table

Cylinder Adjacency table shows which cylinders are adjacent according to the Engine
Block Layout
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Administrator
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Abnormal
Observations

Abnormal Observations are values obtained in the analysis of the data that are outside
the ‘very good’ limits determined for the engine and operating conditions. When outside
the limit, a value is ‘binned’ within 3 grades worse either above or below the limit. (See
‘Possible Causes’)
An administrator is an employee of a company (customer of EnginePolygraph) who has
authority to pay for EnginePolygraph subscriptions, add new users of EnginePolygraph for
the company, and to change the authorizations of the users of EnginePolygraph.

Diagnostic report

DISP or
Displacement

Distributor

Engine Angel
Engine Angel
Report?

Engine Angel
Subscriber
Engine Block
Layout
Engine Features
Engine Flaws

Engine Poly
Purpose

Engine Polygraph
EP Reader
FILE

Date is short for ‘measurement date’. The measurement date is the date when the
associated ‘signature’ file was created using the Engine Polygraph sensors.
The Diagnostic report is an analysis of the data from a ‘Signature’ file of data, data about
the engine model being tested, and some test conditions data. The report evaluates the
‘physical integrity’ of the engine AND an Expert System evaluates ‘Abnormal
Observations’ detected to produce a list of possible causes of the Abnormal Observations
along with a confidence that the indicated cause is correct and suggestions that might
remedy the problem.
Disp is short for displacement. The displacement of an engine is the volume swept out as
the pistons move up and down one time for each cylinder. It is provided by the system
from the Engine Model database and reported in liters.
A company that sells Engine Polygraph kits who have an agreement with Predictive Fleet
Technologies to offer their customers ‘Price Keys’ with special pricing and terms for the
customer and with commission terms that Predictive Fleet Technologies promises to pay
the distributor.
Engine Angel® is the name of the software produced by PFT to analyze the signatures. See
www.engineangel.com .
The ‘Engine Angel Report?’ is a question asking if the system should generate a Report.
There is the normal charge for the Fleet Engine Angel account if the Owner is an Engine
Angel subscriber, or the Engine Polygraph subscriber's account will be charged if the
Owner is not an Engine Angel subscriber for EP reports.
Engine Angel Subscriber is a checkbox filled by the system when it recognizes the Owner
you have input as the same as the Fleet ID in Engine Angel. This causes new adds (when
the Vehicle ID is known as belonging to the Fleet ID) to analyzed by Engine Angel and the
Reports sent to the Fleet ID database of Engine Angel.
An Engine Block Layout is a diagram of the specified Engine Model with cylinder
numbering as known to PFT.
Ignition method, Firing Order and cylinder-to-bank assignment are provided by PFT when
known.
Common Engine Flaws for an Engine Model and time-period are listed for the user’s
consideration when made known to PFT through manufacturer communications or
mechanic blogs.
Engine Poly Purpose is a selection from a pull-down to indicate the purpose of this
signature: Single if it is a ‘one-off’; Before if it is preliminary to a planned ‘procedure’;
After if it follows a procedure; or Base if it is an ‘as-new’ signature for future reference for
deterioration.
Engine Polygraph® is a trademark for the use of EnginePolygraph.com to compare the
‘before repair/treatment’ with an ‘after repair/treatment’ to demonstrate the
effectiveness of the work done. URL is www.enginepolygraph.com.
EP Reader is a PC software to aid in the reliable collection of engine signatures for analysis
and reports provided by the Engine Polygraph and Engine Angel Internet applications.
File is the name of the file created by the oscilloscope. It contains the details of the
waveform generated by the FirstLook® sensor.

© Predictive Fleet Technologies, Inc., 2020; All rights reserved; Patent numbers: US10253716B2 and US 20190304214A1
info@PredictiveFleetTechnologies.com Phone: 1-833-ENGANGL (364-2645)
User Guide, ver 6.00

34

DATE

A graphical representation of the stroke each cylinder is in at any angle of rotation during
its engine cycle.

Page

Cylinder Offset
Diagram

Free Assmnts (Free
Assessments)
LOCATION
MANUFACTURER

MODEL

ODOMETER
oscilloscope

OWNER

Polygraph

Possible Cause

PRICE KEY

Report Selection

RPM

RPM Source

vehicle brand/manufacturer, buyouts and joint ventures can ‘cloud the waters’. In
rare cases, you may need to search the internet to pin down unusual situations.
Model is an identifier of the engine model manufactured by the selected engine
manufacturer. It is selected from a pull down list of the models previously made by the
Engine Manufacturer.
On the vehicle odometer at the time of the visit when the signatures are taken. It is quite
important that either kilometers or miles are consistently used for all vehicles maintained
by the company.
An oscilloscope is an instrument that converts the analog signals to a voltage from the
FirstLook® sensor to a digital value that is recorded in the file.
The Owner identifies the vehicle owner or Fleet name. NOTE: If the name you enter in the
Owner field is the name for a Fleet that has a subscription to Engine Angel Fleet
Management software and has requested that your company provide reports, the Fleet
name will appear in the Fleet field and the Engine Angel Subscriber box will be checked.
Engine Polygraph® is a trademark for the use of EnginePolygraph.com to compare the
‘before repair/treatment’ with an ‘after repair/treatment’ to demonstrate the
effectiveness of the work done.
A Possible Cause is text describing a defect in an engine component that manifests itself
by a set of Abnormal Observations. An engine might have multiple defects so a
Confidence is calculated estimating the relative likelihood that each Possible Cause
detected is actually present. Each Possible Cause may be related to multiple Suggestions.
An identifier of pricing and commission terms that Predictive Fleet Technologies enters
into the Price Key table. (New) EnginePolygraph customers who supply a Price Key name
to the system will obtain the terms and prices that Predictive Fleet Technologies has input
to the Price Key table in agreement with the distributor.
Parameter selected from a pull-down list to specify the report desired from the signature:
Standard (Assessment), Diagnostic (soon-to-be-released Causes and Suggestions for
observed Abnormal Engine ‘Behavior’, or none (when storage of the signature is all that is
desired for the submitted signature.
RPM is the number of revolutions per minute of the engine while the signature is being
recorded in the file.
1. Some engines (many diesel engines) have an electronic speed control by means of a
computer attached to the Electronic Control Module (ECM). If you use such a
capability, enter the rpm that you had set as the controlled engine speed in the RPM
value AND choose ‘Set RPM’ from the RPM Source pulldown.
2. If you have more than two channels on your PicoScope and an induction clamp to
enclose a spark plug wire or COT (depending on your engine’s technology), you will want
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Fleet ID

FirstLook® is the registered trade name of the sensor product produced by SenX
Technology.
Fleet ID is the identifier of the Fleet that owns the Vehicle being tested as known in the
Engine Angel application.
The number of ‘free’ assessment reports that the customer can expect in the first month
following the customer registration.
Location is a description for the shop or garage where the signatures are collected.
Manufacturer is the name/acronym of the engine manufacturer. It is selected from a pull
down list. Although most of the engine manufacturers can be determined from the
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FirstLook

to leave the RPM value blank or 0 AND select ‘Trigger file’ from the RPM Source
pulldown. Then chose a channel (usually ‘C’) on the PicoScope for the input of the
induction clamp cable and set the value for that Channel on the screen to ‘trigger’. In
such a case, the signal will be analyzed to achieve an accurate RPM.
3. If you have an accurate tachometer, you may input the RPM value you will run the
engine at while the data is being collected. It will be important that the value you
provide will be within 15% of the actual value or you may get an erroneous analysis. In
this case, select ‘Estimate’ from the RPM Source pulldown.
4. If you do not have an accurate RPM value, leave the value field blank or 0 AND select
‘None’ from the RPM Source pulldown. In this case, an estimate will be provided from
the Condition option you select [Load, Idle, c-c (Cold-crank)] and the number of
cylinders in the engine. Often this estimate is accurate enough to give a good analysis,
but this is the least reliable of the options.
Rumble

The EP score assigned to the relative intensity of vibrations in a low frequency range in
the crankcase.

Scrape

The EP score assigned to the relative intensity of vibrations of high frequencies in the
crankcase.

Serial Number
Signature
Signature index

The signature index is a set of attributes describing the vehicle, owner, operating
condition with date and location to allow easy retrieval in the future.

Subscr
(Subscription rate)

The monthly rate (in US dollars) that is charged against your credit card for access to basic
signature management functions. Assessment reports are optional for a fee.

TEMP or Engine
Temperature

Temp is short for the temperature of the engine coolant at the time the signature is
taken. If he input value is less than 105, it will be interpreted as °C, else °F.
Each Possible Cause may be assigned multiple Suggested Remedies. A Suggested Remedy
may correct or influence more than one Possible Cause and hence, multiple Abnormal
Observations.
The number of ‘free’ months of subscription that the customer can use EnginePolygraph
without paying the subscription fee.
The cylinder number (according to the OEM’s engine block layout) of the cylinder you
have placed a trigger to identify that cylinder on the EP graphics and the firing sequence
of the test engine. You must also identify the channel that contains the trigger signals to
the PicoScope.
User is the identifier of a person authorized to access the EnginePolygraph system. Users
are added and authorizations given by a specific group of users called Administrators.

Suggestion
Trial Months

Trigger Cylinder

USER
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SenX

This box allows the user to specify an email address as the destination of the PDF
Assessment report.
SenX® is the registered trade name of the company that manufactures the FirstLook®
sensors.
Serial Number is the engine manufacturer’s serial number provided by the Engine Angel
Engine table IF the Owner is an Engine Angel subscriber and the Vehicle is registered in
that Engine Angel Engine table.
A signature is the name of two or more simultaneous waveforms taken with FirstLook®
sensors from a specific engine under given operating conditions in one file.
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Send Assessment
to:

Upload File
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VEHICLE

The Choose File button prompts a window for the search of the User terminal's attached
storage devices to identify the signature recorded by the oscilloscope. The result is to
store the selected file in the EnginePolygraph database for later reference.
Vehicle is the identifier of the chassis containing the engine that is being serviced and
whose signature is being recorded. In the case of a fleet vehicle, is commonly the
identifier painted on the vendor or door of the vehicle; in the case of personal
automobiles or pickups, it might be the license plate number or other unique identifier.
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Appendix 2. PicoScope Settings for Engine Polygraph
Signatures.
The PicoScope software controls many important settings for capture, display, and storage of your
FirstLook® Signature data. The key parameters are shown in Figure A2.1. This document is focused on
use of the PicoScope to obtain Engine Polygraph® Assessment reports on engine physical integrity.

Figure A2.1. Image of the PicoScope screen with settings that we recommend for most signatures.
The values of the PicoScope screen with settings that we recommend for most signatures are shown in
Figure 1 above; hence we suggest that you might want to put these values into your settings and
preferences and store them as defaults. In those cases when other settings are appropriate, you can
make the needed changes; and when done, re-load the default settings.
We provide our recommended settings as a download from the website, www.EnginePolygraph.com.
When you download the ‘suggested.pssettings’ and store it (Save As) somewhere on your PC, you can
start your PicoScope6 Automotive application and chose File > Open to select the downloaded
suggested.settings. This will import the settings to your session. From there, you may want to go to File
> Startup Settings > Save User Default Settings and also check the box: Load User Default Settings on
Startup.
We now will discuss why we provide the recommendations that we do and how you may modify them
as needed. This is not meant to replace your use of the PicoScope6 Automotive documentation.
The settings and preferences screens are where you control some of these the settings. First, let’s look
at the ‘preferences’:
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This parameter is critical for obtaining a meaningful report since the software that generates the
signature Assessment report requires at least 2.7 cycles of all cylinders firing. For a 4-stroke engine,
that is 5.4 rotations of the crankcase. If the engine is running at 1500 rpm, one 4-stroke cycle takes
80ms, so the time (duration) on the screen should be 216 ms, and longer if the engine is running
slower. We recommend 500 ms which should be acceptable until about 650 rpm (typical idle).
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1. The time interval displayed on the screen can be controlled on the Tools > Preferences >
General screen. The choices are to set the time interval across the screen (Total collection time),
or to set the total sweep interval in terms of the time between the 10 equi-distant vertical bars
(Times per Division).

2. The Preferences > General screen also controls the Waveform Buffer. This parameter controls
the number of waveforms that may be stored in the buffers.
Although having up to 32 buffers is very useful for some analyses, we recommend that you set it to
1 for signatures that are to be analyzed by the EnginePolygraph application. The reason is to make it
easier to save the signature on your PC and then sending it to EnginePolygraph for analysis.
EnginePolygraph cannot take the set of signatures as a group for analyses, but can only process one
at a time.
Figure A2.2 shows the layout of the Preferences > General screen. You may want to review the
settings on the other Preference tabs also.
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Other parameters that can be stored in your Default settings can be altered immediately below the
menu bar. Under Tools, is the sample frequency. See Fig. A2.3. We recommend about 40kS (40,000
samples per second) to get good detail of what is going on in the engine. We do not have any properties
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Figure A2.2. The PicoScope6 Tools > Preferences > General screen for controlling important parameters
to get EnginePolygraph Assessment reports on engine physical integrity.
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that we consider in the analysis that interpret data at a higher frequency, but higher frequency of
sampling increases the file size and slows down the ability of the PC to do any other work.
On the next row under the menu bar, the voltage range for each channel is displayed; it can be changed
and stored in the Default settings.
For channel A (which we use for the exhaust), we recommend +/- 10 volts. In some cases, this is
not enough. If the voltage actually exceeds the range, the data file will record the value as Inf
(infinity). The program will try to estimate such values, but if there are too many, it will ‘give up’
and give an ‘Exception report’, indicating that the Assessment is not reliable.
For channel B (which we usually use for the crankcase sensor), we recommend +/- 5 volts.
Usually the voltage (pressures) are lower in the crankcase than in the exhaust.

Figure A2.3. These are the Startup Settings on the PicoScope6 File > Setup Settings Menu.
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1. The ‘Save Settings As …’ allows you to save the settings under a unique name in a specific
directory of your choice for future reference.
2. ‘Save User Default Settings’ is used to save the current settings as your Defaults in the future.

40

Once you have selected the settings that you want to use going forward, we recommend that you click
‘Save User Default Settings’ to save them. But we also recommend that you click on ‘Load User Default
Settings on Startup’ to simplify future use of this PC for use with EnginePolygraph. Below is a short
description of the behavior for each of the menu items of the File > Startup Settings list.

3. ‘Reset User Default Settings’ can be used to go back to the last saved Default Settings in case
you have changed the settings during the session, but now want to go back to the Default
Settings.
4. Use ‘Load User Default Settings’ to read the Default Settings and use them going forward.
5. ‘Restore Last Session’ will reload the settings from your previous session.
6. ‘Load Factory Settings’ will reset the current settings to the values from the download of your
PicoScope software.
7. Checking ‘Load User Default Settings on Startup’ will cause the system to load the default
settings in the future on start-up.
8. Or you may check ‘Restore Last Session on Startup’, if that is what you prefer.
If you are not fully trained on the use of your PicoScope, you will want to use the Pico literature and
Help screens to get full value from your investment. The material above is presented to focus on the
capabilities important for using your PicoScope to obtain SenX signatures for EnginePolygraph Engine
Integrity Reports.
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We wish you great success on the use of your PicoScope and the Engine Polygraph®
(www.EnginePolygraph.com). Engine Polygraph is a product of Predictive Fleet Technologies, Inc.
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